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1. LIFTdesigner 5 Imperial Quick Tour  

This LIFTdesigner Quick Tour provides an introduction to the program, walking you 
through the creation of an elevator project using LIFTdesigner Version 5 
We recommend that both new users and familiar users with older versions of the 
program try Quick Tour and work through the example project. This gives you a 
clear view of the basic functions of the program and how it works. 

 This symbol identifies paragraphs with instructions for operations or for data 
that you need to enter.  

 This symbol identifies paragraphs containing important information and 
warnings. 
 

We hope that you will enjoy working with the new, powerful version of 
LIFTdesigner 5. 
  

2. Installation & System Requirements 

2.1. Hardware and Software Requirements 

To run LIFTdesigner 5 efficiently, your computer should meet the following, 
minimum system requirements: 
 

CPU:    Pentium 4, 1.4 GHz (Pentium 4, 2 GHz recommended) 
 

Memory: 512 MB RAM (1024 MB recommended) 
 

Hard disk: Approx. 500 MB of free disk space 
 

Video card: 128 MB memory (3D hardware acceleration 
recommended) 
 

Pointing device: Windows compatible mouse 
 

Operating system: Windows 2000 Professional (SR4 or later); Windows XP 
Professional / Home Edition; Windows 2000 / 2003 Server 
 

Additional software: AutoCAD 2004 / AutoCAD 2004LT (or a higher version) is 
recommended. 
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2.2. Installation 

Close all other applications before you start the installation.  
 

 You must have administrative rights to installation LIFTdesigner 5. 
 
Step1: 
Place the DigiPara Suite CD in your CD-ROM drive or download the single 
executable installation file from http://www.LIFTdesigner.com/ 
 
Step2: 
 
CD Version: 
If Auto run is enabled, the installation will start automatically. If Auto run is not 
enabled, select Run from the Start menu and type D:\setup (substitute the 
appropriate letter of your CD-ROM drive for D). 
 
Single Executable File: 
Double click on the downloaded executable file to start the installation. 
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Step 3: Follow the instructions on the screen. 
 
1. Welcome screen: 
Click on the Next button to start the 
Installation. 

2. License agreement: 
Accept the license agreement to continue 
the installation process. 

 
3. Customer information: 
Enter your name and the name of your 
Company. 

 

4. Installation location: 
Confirm the default path or change it to a 
different installation location. 

5 Setup type: 
Select the Setup Type. 
  

6. Select features (Custom installation): 
Select the program features that you would 
like to install. 
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8. Confirm installation: 
Confirm this dialog to start the installation. 

9. Setup Status: 
The installation is running. 

 
10. Installation Finished 
Click Finish to launch LIFTdesigner 5. 

 
 

 
The installation time depends on the computer’s hardware as well as on the 
operating system. Some computers will need to be rebooted after the installation 
has finished. 
 

 LIFTdesigner 5 is based on the Microsoft .NET framework technology. The 
installation of the framework environment takes about 50% of the installation 
time. If the .NET framework 2.0 has already been installed on the target 
computer/s, the installation process will be faster. 

2.3. First Starting LIFTdesigner 5  

When you run LIFTdesigner 5 for the first time, an initialization dialog will come up 
asking you to specify the program language as well as the user group type.  
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 You can also change the language as well as the user group later in the 
program. 

 Choose your settings and click on the OK button. You do not need to define the 
data pool settings manually. 

 

 
 
The data pool contains all the relevant data that is necessary to run the 
program, e.g. the system database, user interface files, manufacturer 
libraries, etc. From the program aspect, this means that the program files 
(executables, libraries, etc.) are separated from the program data (user 
interface data, system data, manufacturer data, etc.). 
 

 Advanced users, e.g. LIFTdesigner component developers who are already 
familiar with the data pool subject, are free to manually define the data pool 
settings. For all other users, we recommend that you use the default settings. 
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2.4. LIFTdesigner 5 Authorization 

When LIFTdesigner 5 starts for the first time, the Licensing dialog will appear 
asking you for your license information.   
 

 
 
Choose between one of the following options: 
 

2.4.1. Register and Authorize LIFTdesigner (get an authorization code) 

 Click on the Next button. A dialog box appears asking you for your Serial 
Number (this is a long number for ex. 123AB-12345-ABC34-ABC45-FG567) 
and Authorization code. Enter the necessary information and click on the OK 
button. If you have entered the correct information, LIFTdesigner 5 will be 
activated. 
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2.4.2. Request the Authorization code via the Internet 

If you haven’t obtained your authorization codes yet, please proceed as follows  
(this procedure requires Internet access): 
 

 Click on the button “3. Request your Authorization Code via Internet”. 
 
The LIFTdesigner Authorization website will be displayed.  
 

 
 

 Enter your Serial number in the corresponding field and click on the “Next” 
button. 
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 Then enter your email address in the corresponding field and click 
on the “Send” button. 

 

 
 
The Authorization codes will be sent to the specified email address.  
 
After you have received the email containing the necessary LIFTdesigner 
authorization codes, please proceed as follows to finalize the authorization 
process: 
 

 Copy the authorization codes from the email to the text box. Please copy only 
the Authorization codes content starting with the term “MODULE:” (to copy – 
Ctrl + C). 

 

 
 

 Now paste the copied authorization codes into the corresponding text box in the 
LIFTdesigner “Licensing” dialog: (To paste – Ctrl + V) 
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 Then click on the button “6. Accept codes and Verify the Licenses for your 
Module” to activate LIFTdesigner. Check if all your LIFTdesigner modules are 
valid in the appearing “LIFTdesigner - Modules” dialog. 
 

  
 

 If all modules are valid, click on the Close button. Now click on the enabled OK 
button in the Licensing dialog. The authorization process has finished. 

2.4.3. Buy LIFTdesigner 

When you select this option, you will be redirected to the LIFTdesigner website 
(requires Internet access). On the website, you have the possibility to purchase 
your LIFTdesigner 5 version. 
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3. Starting the Program – Creating a new Project 

3.1. The Basic Structure of the Program 

LIFTdesigner  has three main components: 
 
Designer: This is the main part of the program. It includes the user interface that 
enables you to enter and edit the dimensions and properties of your elevator.  
To change dimension values, just click on a dimension and edit the value in 
LIFTdesigner’s Properties window. 
You can make changes in any view – all changes are automatically implemented 
throughout the entire data model.  
 
Database: The specifications and geometrical data of selectable elevator 
components are stored in the LIFTdesigner database. DigiPara continually 
updates this database with the latest components and data. In addition to this, 
users can also enter their own components into the database. 
 
Programming interface: Engineering calculations, collision factors, limit value 
checks, component selection criteria, customized program dialogs, editing 
limitations, etc. are all implemented in the individual modules, which are separate 
from the main LIFTdesigner program code. These modules can be started from 
within LIFTdesigner and they have full access to all the data of your elevator 
project. The results of the calculations can be displayed using the “Checking 
Report”, for example.  
Please note that all editing functions are disabled when external program modules 
are running! 
 
It is not possible to guarantee that custom components are compatible with your 
elevator project, if no company specific configuration procedures have been 
defined via the programming interface. It is possible to perform recalculations for 
some components, even though you should always have the project checked 
thoroughly by the manufacturer or responsible engineer before implementation. 
 

3.2. Downwards Compatibility 

Your old LIFTdesigner project files, created with LIFTdesigner 4.0, can also be 
edited with LIFTdesigner 5. 
 

 When you open an old LIFTdesigner 4 project file with LIFTdesigner 5 and save 
it, the file cannot be opened anymore with the old version of the program.  For 
this reason, we recommend that you to make a backup of your old project files 
first. 
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3.3. User Interface Configuration 

The first time you start the program you will see that only a couple of toolbars are 
displayed on top of the main program window.  
 

 
 

 To display additional toolbars, click on the right mouse button in the toolbar 
area and click on “Customize” in the appearing context menu. 
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3.4. LIFTdesigner 5 Toolbars 

The following toolbars are available in LIFTdesigner 5: 
 

 
 

1. File and docking Window operations 
2. Provides the most common features a Standard user will need 
3. View commands and object select operations. 
4. View frame settings: Texts, component detail levels and additional 

dimensions 
5. Sheet operation - open, save, load and delete sheet; add and remove DWG 

overlays 
6. View frame operations: load, save, add and remove view frames; View 

frame views ->Plan, verticals, MR, sheaves, wall opening, 3D and DWG 
view 

7. Sub-options for view frames 
8. Visibility of basic shaft components. 
9. Dimensions on/off for basic shaft components. 
10. Drawing languages (to be configured first). 
11. Project settings like Edit-/Print mode, Dimensions Captions, Disabled 

dimensions, sheet selection, Color and line weight settings 
12. Component developer operations 
13. Group elevator operations: Add, remove shafts, display / hide shafts, shaft 

dimensions  
14. VBA and .Net application operations  
15. Dimension operations 

 
You can move the toolbars to any position on the screen (left mouse-click on a 
toolbar and drag it).  
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Whenever you create or open a project file (*.LD3), a new LIFTdesigner document 
window is opened automatically. LIFTdesigner 5 will look something similar to the 
example shown above. 
 

3.5. LIFTdesigner Properties, Data Tree, Checking Report 

The new user interface has been completely developed from scratch. The structure 
and content of the pull-down menus is similar to LIFTdesigner 4.0. 
 
The old property cards have been replaced by a standard LD properties window, 
which is used in other known applications as well. E.g. AutoCAD is using the 
standardized property window.   
 
If you don’t see the LD Properties window in the LIFTdesigner 5 main window, you 
need to activate it in the “Window” menu: 
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The calculation checking report, the LIFTdesigner component data-tree, the 
dynamic 3D View and the new Quick Help are also located in separate docking 
windows. Activate them by clicking on the appropriate item in the “Window” menu. 

3.6. Properties Docking Window 

The Properties window is divided into different sections, which provide component 
/ dimension specific information and options. 

In the following example, the landing door properties will be explained. 

 

 In the LIFTdesigner document window, click on the landing door, e.g. in the 
plan view. 

 

 



 

__________________________________________________________________ 
LD Quicktour V5, Sept. 2007  © DigiPara GmbH 

     Starting the Program – Creating a new Project   17 

 
The landing door properties are displayed in the Properties docking window: 

 
 
 
1. The General section contains manufacturer specific information as well as the 

opportunity to exchange the component. 

Manufacturer Displays the component manufacturer. Click on the button in 
the value field to exchange the component. 
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Designation Displays the component model. Click on the button in the 
value field to exchange the component. 

Type Displays the component’s design (type, size, etc.). Click on 
the in the value field to exchange the component. 

 

2. The Grouping section contains landing door specific shaft global information. 

Grouping Select whether the door settings shall be applied to the 
selected door only or if they shall be applied to the other 
landing doors as well. 

 

3. The Door Dimension section displays information according to the door 
geometry. 

Height:  Displays the landing door height, this value is editable. 

Width: Displays the width of the currently selected door. Click on the 
button to quick select a different door width (this option is 
only available if the selected door is part of the installed / 
authorized manufacturer libraries). 

Extended Door 
Dimension: 

Click on the button in the value field to open the extended 
door dimension dialog. 

      

Make your individual changes to the selected landing door 
and close the dialog.  

Hint: You need to exchange the door to reset the user-
defined settings. 
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4. The View Frame Settings section provides additional component display and 
dimension options. 

Detail 
Status: 

By Frame:  
The component’s detail level is set by the view frame’s detail 
level. 

Delete from frame:  
Deletes the component detail status from the active view frame. 

Other:  
Provides the opportunity to select between different component 
detail levels, independent from the view frame detail level (must 
be supported by the component). 

Dash: Provides the opportunity to display the selected component 
dashed. 

Extended 
Dimensions: 

Provides the opportunity to display the extended component 
dimensions permanently. 

 

5. The Quick Component Link box contains quick links to the parent-; parallel 
existing- and child- components of the currently selected object (the marked 
quick-link).  
 
The parent components are red. In this case, the entrance list “...\Entry 0” is the 
parent object of the selected landing door.  
 
The parallel existing objects (located under the same parent node in the 
hierarchical data tree) are blue. The “Entry Pocket” and the “Wall Opening”, for 
example, are located under the same node (parent object) as the landing door. 
 
The child components are green.  

 
 

 Click on one of the quick links, to browse through the different elevator 
components. Click on the “Jamb” component for example, to display its 
properties in the Properties window. 
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The displayed properties vary depending on the selected component. Take a look 
at the different components properties by using the links in the Quick Component 
Link box. 

3.7. Change Dimensions in the Drawing 

There are two ways to change a dimension value: 

 Double click on a dimension in the drawing and change its value in the 
appearing Quick Edit window dialog. 

 

 
 

 The second way is to click on a dimension once and change its value in the 
Properties window. 
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3.8. The ShaftWizard 

The ShaftWizard  helps you set up the basic parameters of your new elevator 
project. Start a new project by clicking on File and selecting New from the menu. 
This starts the ShaftWizard, which displays a series of dialog boxes in which you 
can select and enter the information for your elevator. While the ShaftWizard is 
active, the changes generated from your entries are displayed automatically in the 
view window in the background. For this exercise, please enter the parameters 
shown in the example below.  

 All the entered values and selected components in the ShaftWizard can be 
changed later when you are editing the project – so there’s no need to worry 
about making mistakes! 

 The main purpose of the ShaftWizard is to select a standard elevator system as 
a basis for your project. When you are starting a project with a new elevator 
type that you have never used before, use the ShaftWizard to define the 
elevator type and other basic system parameters. (The standard version of 
LIFTdesigner 5 does not include standard specifications for the products of 
specific companies.) 

 The elevator components included in the project when the ShaftWizard closes 
are not  the result of the calculations. They are read automatically from the 
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“duty tables”.  This is where the standards for the products of specific 
companies can be stored.  

 

 Enter the following data in the first dialog box: 
 

Project number:  09876 
Project name:   Insurance Company 
Commission number:  54321 
Drawing number:  1234 
Prepared by:   Your Name 
Date:    The Current Date 
Project Unit:   Metric 
Elevator designation:   Passenger elevator 
Elevator number:  1 

 

 This data does not affect the technical part of the project. Later on you will see 
this text information in the drawing or in the title blocks. You can also change 
the project data later by selecting Specifications... in the Project menu. 

 

 
 
 

 In the next dialog, enter the basic parameters for the elevator drive type. Enter 
1000kg in the Payload field. Click on the “with Counterweight safety gear” box 
to disable this option.  

 



 

__________________________________________________________________ 
LD Quicktour V5, Sept. 2007  © DigiPara GmbH 

     Starting the Program – Creating a new Project   23 

 
 

 All the values entered and components selected in the ShaftWizard can be 
changed later on when you are editing the project – so there’s no need to worry 
about making mistakes! 

 
 

 
 
 

 Next select the settings used in the above rope arrangement dialog (4 
selections). Click on the Select... button to choose a different standard elevator. 
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 Select a system with a car size of 80x51’’. You can move down through the 
hierarchical tree structure by clicking on the “+” and “-” symbols.  To select the 
car size, click on the lowest level in the appropriate branch.  As shown above, 
the “5600000” is the lowest branch for choosing a car size of 80x51’’.  Please 
click on “5600000” then on OK to close the dialog. Click on Next in the “Design” 
dialog. 

 

 
 
 

 Set up the values for the storey height, the floor thickness, etc. You can also 
select a different landing door type by clicking on the Select button. Click on the 
Next button to display the next dialog. 
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 Enable the rear entrances for both entries. In the floor level list you can edit and 
modify floor level specific values. After selecting a floor level, you can also 
insert or remove floor levels by clicking on the appropriate buttons on top of the 
floor level list: 
 

Insert above: Inserts a floor level above the selected floor 
Insert below: Inserts a floor level below the selected floor 

 
In the last dialog box, you can select different sheet templates from a list to be 
loaded with the new project. The sheet templates are located in the data pool’s 
sheet directory (e.g. “C:\Documents and Settings\Your Name\My 
Documents\DigiPara\CustomPool\sheets\*.*”).  
 

 You can also create your own sheet templates and store them in the sheets 
directory. The next time you run the ShaftWizard, your own sheet templates will 
also be available in the list. 

 

 Then click on the Finish button to close the ShaftWizard. 
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3.9. Main Project data 

When you close the ShaftWizard, the following message is automatically 
displayed, asking you weather you want to display the main project data for editing. 
 

 
 

 Select Yes to display the main project data. 
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 Change the Shaft values as shown above. Adjust the values until you achieve 
the figures shown in the illustration.  Please don’t click on “Close” as this will 
exit you from the dialog. 
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 Click on the Car node. Change the car width and depth according to the 
example shown above. Enter a ceiling height of 2’’ and a car height of 88’’. 
Change the Bottom run by to 14 and the Top run by to 6. 

 

 
 

 Under the Weights Category, enter the values shown above (they are needed 
for the calculations later on), then click on Close to close the dialog box. 
LIFTdesigner now displays a rough layout of the elevator.) 

 

 You can edit the main project data directly by right clicking anywhere in the 
document window and selecting the appropriate option from the context menu.  

3.10. Other Project data 

You can enter other data relevant to your project by going into the Project menu 
and selecting Specifications….   
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The project specific information is displayed in the LIFTdesigner Properties 
window: 
 

 

4. Plan view 

4.1. Change view 

You can adjust the current project drawing view by using the tools in the Edit and 
Project toolbar.  
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4.1.1. Edit Toolbar 

 
 
From left to right: 
 

1. Zoom All: Adjust the zoom scale to show all the views available in the 
current drawing. New: Use the mouse scroll wheel, see picture 7 in chapter 
4.1.2. 

2. Zoom Previous: Restores the last drawing zoom scale. 
3. Move: Enables you to move the drawing within the current window by 

clicking on two points to define the move (the distance and direction 
between points 1 and 2 & specify the move). Alternatively you can also 
move the drawing with the cursor keys. New: Use the right mouse button, 
see picture 4 in chapter 4.1.2. 

4. Zoom In: Enlarges the current zoom view or press the “+” key, or use both 
mouse buttons and move the mouse. New: Use both mouse buttons or the 
mouse scroll wheel, see pictures 5/6 in chapter 4.1.2 .  

5. Zoom Out: Opposite of Zoom In (or press the “-” key). See picture 5/6. 
6. Zoom Window: Clicking on the two diagonally opposite corners points of an 

imaginary rectangle & it zooms the selected rectangle to fill the window.  
7. Annotation Select: Draw a rectangle over the annotations you want to 

select. 
8. Dimension Select: Draw a rectangle over the dimensions you want to select. 
9. Component Select: Draw a rectangle over the components you want to 

select. 
10. Delete objects: Delete the selected objects. 
11. Measure: Click on the left mouse button to specify the start point, move the 

mouse and click on the left mouse button again to specify the end point. 
You can also press the spacebar to define the start point, then move the 
mouse cursor and press the spacebar a second time. 

4.1.2. How to use the Mouse         

4. 5. 6. 7.

4.1.3. Project Toolbar: 
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From left to right: 
 

1. Toggle View: Toggle between design and print mode (see chapter 4.3). 
2. Dimensions captions: Display, hide the dimensions captions 
3. Show disabled dimensions: Display hide disabled dimension in print mode.  
4. Switch sheet: Select between the available sheets 
5. Floor level dialog: Display the floor level dialog 
6. Background color: Switch between black and white background color. 
7. Line style: Toggle line thickness on/off. Important for direct printouts. 
8. Foreground color: Switch between colored and monochrome foreground 

color. Important for direct printouts.  
9. Plot style: Switch between different plot styles for the selected BG / FG color 

and line style configuration. 

4.2. Dimension Text Configuration 

The texts displayed in the drawings for dimension chains and automatic texts 
preceding individual dimension values, can be modified for the entire project or for 
the selected frame only. Click on the car width dimension (from the elevator 
screen, it’s located at the top among the other dimensions) to display its properties. 
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Change the information for the “Prefix (related to frame)” value. Type “CW” SPACE 
“interior” SPACE “=”  in the input field. The selected dimension’s prefix text in the 
active view frame will change to the new value. 

 If you change the information for the Prefix value, these changes will 
automatically take effect in all view frames of the current project, as well as in 
all existing and new LIFTdesigner projects.  

 
Repeat the same procedure for any other dimension text you’d like to change. 

4.3. Design and Print mode 

The view frames have two different display modes: Design Mode and Print Mode. 
When the Design Mode is active all editable dimensions are shown in blue. 
 
The Print Mode displays cross-hatching, colors, and line thickness and removes 
hidden edges. You will normally want to activate this mode for clearer visualization 
of the drawing on the screen or to print the drawings.  
You can toggle between the two modes by enabling / disabling the Design Mode 
button in the Edit toolbar as shown below.  
 

 

4.4. Shaft Depth and Entrances 

4.4.1. General Check 

 This check is part of the calculation module. First save your project file then 
click on Results… in the Calculation menu. This command performs geometrical 
and engineering calculations for the entire elevator system and displays the 
results in the Calculation Report docking window. 

 Select the “Common Report.Components.Report” entry from the list box at the 
top of the window to display the standard components checking report.   

 This report provides LIFTdesigner internal common geometrical and 
engineering calculation results (not acc. to EN81). If a result is invalid (marked 
red), click on the “Component name” entry to display the properties regarding to 
the component that caused the error.   
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 To display the EN81 calculation results (requires the EN81 calculation module), 
select the “EN81.Components.Report” entry from the list box at the top of the 
dialog. 

 If the Checking report window doesn’t look like the example above, you can 
resize it by dragging the bottom left corner. You can also adjust the column 
widths for better legibility by dragging the column heading dividers with the 
mouse, or use the “Auto fit columns” option in the top section of the docking 
window. 
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4.4.2. Changing Components: Landing Doors 

First we want to replace the default door (S2L, 36’’) with another model (S4C, 36’’). 
There are two ways to display the landing door’s component dialog: 

 Double click on the landing door to display the component navigator dialog. 
 

 
 

 First select the door in the drawing. The door will then be marked red to 
indicate that it has been selected. After you have selected the door, its 
properties will be displayed in the Properties docking window. 
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 Now click on the button in the Manufacturer, Designation or Type value field to 
open the landing door’s component dialog. 

 
The component navigator dialog appears on the screen: 
 

 
 
Components are selected from the hierarchical tree structure, displayed in the left 
part of the window. The doors are sorted by manufacturer, internal designation 
(e.g. S2L for Shaft landing door, 2-leaf, Left-opening), catalogue code and door 
width.  
 

 Click on the “+” and “-” icons to navigate through the tree structure (you can 
also double-click on the individual entries). 

 Select the door as shown above and then click on OK to exit the dialog. 
LIFTdesigner 5  will then automatically ask, “Automatically select suitable car 
door?” Answer this prompt with Yes.  

 
By disabling the Drawing view box, you can shorten the display time. (Click on the 
Window button and uncheck the Drawing View item in the appearing Navigator 
configuration window as shown below).  
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Now perform the same steps for the rear door (select the same door model). 

4.4.3. Determine the Shaft Depth 

Your current shaft depth has a value of 111.98’’ but you need a shaft depth of 
111.58’’. There are two ways to obtain the necessary 0.4’’ increase in shaft depth: 
 

 Click on the shaft wall in one of the view frames: 
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 In the Properties window, change the door wall clearance (distance between 
the door frame and shaft wall) in the Shaft Depth section from -1.6 to -1.8’’ for 
both sides.  

 Or click on the corresponding blue dimensions in the drawing... 
 

 
 
...and change the values from -1.6 to -1.8’’  (remember to do this for both 
entrances). 
 

 As you have probably noticed, it is not possible to change the shaft depth 
directly. This is because this dimension is the sum of a linked chain of other 
dimensions. If you change one of the dimensions in a linked chain, all the other 
dimensions remain constant and this naturally results in a change in the total 
shaft depth. The reason for this behavior is that LIFTdesigner 5 has no way of 
knowing how it should modify the elevator system when you alter a value that is 
relevant for the shaft dimensions – there are simply too many degrees of 
freedom to make a clear decision. This is why it is the responsibility of the user 
to check the shaft dimensions. 
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4.5. Car Guide Rails and Distance Between Guides (DBG) 

4.5.1. DBG 

You need to set a cab wall thickness of 1.2’’ with a DBG of 47.6’’. Like the shaft 
dimensions, the car DBG is a sum of linked chain of dimensions. This means that 
changing the wall thickness will also automatically change the cab DBG.  
 
There are two ways to obtain the target DBG value: 
 

 Click on the shaft in the view window. This displays the properties for the shaft 
again. Now change the left and right cab wall thickness to 1.2’’ (in the Shaft 
Width section).  

 Click on the corresponding blue dimensions in the drawing and change them 
directly... 
 

 
 
...from 1 to 1.2 for both sides. 

4.5.2. Car Guide Rails 

 Zoom in on one of the car guide rails and display its properties. 
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 This is a T90 rail. Now click on the parent Guide rails component node in the 
Quick Component Link box to display the guide list properties. 

 
 

 
 

 In the Guide rails Tools section, click on the Start Calculation... button in the 
Calculations field,  

 

 
 
to open the Guide rail calculation dialogue.  
Note: Guide rail calculation is only available for EN 81 projects, not for other 
standard like A17.1.  
 
 

4.6. Positioning the Governor 

 Select the Safety Gear/Governor unit: 
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 First select the opposite side for the safety gear trigger point. If you can’t select 
the Safety gear directly, use the Quick Component Link box (click on it) and 
show its properties.  

 

 
 

 The safety gear is located under the same parent-node (“Car Frame”), as the 
governor. Click on the governor component link (“..\Overspeed Governor”) to 
show all the components that are located under the ”Car Frame” node 
(alternatively, use the black quick link to display the safety gear properties 
directly). 

 
 

 
 

 Now click on the “Safety gear” link to display the safety gear’s properties:  
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 Select the opposite side for the safety gear trigger point under Force Attack 
Point -> Location in the properties window. 

 
Select this location:  

 
      

 Now click on the “Overspeed Governor” link in the Quick Component Link box 
(use the black quick link in the hyperlink box) to switch the governor’s 
application point to the other side (XY-Direction > Preset direction). 

 



 
 

__________________________________________________________________ 
© DigiPara GmbH  LD Quicktour V5, Sept.  2007 

42 Plan view  _

 
 
Select this location: 

 
 
Once you have moved the “Passenger elevator...” text, the section of your drawing 
that we have been editing, should now look something like shown below:  
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4.7. Rail Brackets and Shaft Width 

Now we are going to modify the rail brackets and the counterweight.  
 

 Double click on the rail bracket and select another counterweight bracket 
according to the following illustration: 

 
 

 
 

 Next, click on the counterweight DBG dimension and change it to 30’’ (see 
below). Then move the counterweight 22.5’’ back towards the rear shaft wall. 

 
The drawing should now look like this: 
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Next we are going to modify the rail brackets.  
 

 Click on the rail bracket, to display its properties and click on the 
subcomponents button in the Properties window’s General sections. Activate 
the following components (working from top to bottom):  

 

Car guides – interim piece – 2 x L 
profile: 300 (rectangular) 

-> 2 L sections as variable connecting 
components for the rail mountings. 

Car guides – rail fixing – long profile 
for rectangular 300 

-> Long section on which the cab rail is 
mounted. 

CWT guides left – interim piece – 
fixing at rear wall 

-> Left side section for fastening the 
counterweight rail guides. 

 

 Deactivate all other rail bracket sub-components. Go through the entire list of 
sub-components from start to end to make sure that you’ve got them all: 

 

 
 
Your drawing should now look like the example below: 
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4.7.1. Determine the Shaft Width 

Your current shaft width has a value of 67.1’’  but you need a shaft depth of 64’’. 
One way of achieving the target value of 64’’ is to reduce the distance between the 
cab and the counterweight. Once again, there are two possible ways to do this:  
 

 Click on the shaft and change the Left distance counterweight / car dimension 
in the Shaft Width section from 8 to 4.9’’.  
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 The second way is to double click on the corresponding blue dimension in the 
drawing... 

  
 
...and to change the value from 8 to 4.9 in the Quick Edit dialog. 
 

 As you have probably noticed, it is not possible to change the shaft width 
directly. This is because it is the sum of a linked chain of other dimensions. If 
you change one of the dimensions in a linked chain, all the other dimensions 
remain constant and this naturally results in a change in the shaft dimensions. 
The reason for this behavior is that LIFTdesigner 5 has no way of knowing how 
it should modify the elevator system when you alter a value that is relevant for 
the shaft dimensions – there are simply too many degrees of freedom to make a 
clear decision. This is why it is the responsibility of the user to check the shaft 
dimensions.  

4.8. Pit Ladder 

 Enable the pit components to activate the pit ladder. 
 

 
 

 Note: The pit ladder dimensions are only displayed when the ladder is selected! 
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 Change the appropriate value from 2 to 10 to move the ladder 8’’ deeper into 
the shaft, so that it is farther away from the shaft door. 

 
The dimensions of some components are only displayed when the components are 
selected. This makes the drawing less complex, while still enabling you to display 
the less important dimensions when you need them.  
 

 If you wish, you can also activate all of these dimensions in the Edit Object 
toolbar by clicking on the icon shown below.  

 

 
 

 Hide the pit components by pressing the corresponding button again. 
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4.9. Configuring and Saving Views 

4.9.1. Dimensions 

You can store dimension and view setting configurations in “drawing templates”. 
To do this, first switch to the print mode (the shaft is shown with cross-hatching). 
Now you can move the dimension texts in the drawing by clicking and dragging it 
with the left mouse button. 
 

 To move more than one dimension at once: Click on the Select Dimension 
Objects button in the Edit toolbar and draw the selection box over the 
dimensions that you want to move / modify. 

 

 
 

 To display dimension’s extension lines: Proceed in the same way as above. 
Then click on the Extension Line buttons in the Dimension Settings toolbar. 

 

 
 

 To disable dimensions: Select all dimensions you don’t want to show and 
disable them by clicking on the Delete Objects button in the Edit toolbar.  

 

^ 
 
If you don’t want to display the disabled dimensions (colored light gray, after 
disabling), click on the Show Disabled Dimension status button in the Project 
toolbar.  
 

 
 
After making a few changes using the options described above, your drawing 
should look something like the example on the next page. 
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4.9.2. Scale and Hatching 

 Click on the View frame to display its properties in the LIFTdesigner Properties 
window: 

 

 
 

 Select a finer hatch by editing the corresponding “Scale” value. 
 
 

4.9.3. Configure Line Weights / Layers 

There are two ways to change the line weight / color and background color: 
 

 Click on the appropriate status buttons in the Project toolbar. 
 a. b. c.

 
 
a: Switch the background color from black to white and reverse. 
b: Switch the line weight to thin / thick and reverse.   
c: Switch the foreground color from colored to monochrome and reverse. 
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 Another way is to select Sheet Properties… in the Sheet pull-down menu to 
display the sheets properties. Now click on the Sheet component in the Quick 
Component Link box to display the global sheet properties. 
 

 
 

 When you select another Plot style value or change the status of the buttons in 
the Project toolbar, to change the line weight, the fore- and background color, 
these changes affect all of the LIFTdesigner frames and sheets in the current 
document. 

 

4.9.4. Saving your Settings 

You can now save these settings in the project file and in a sheet template file for 
use with other similar projects.  
 

 Saving the settings within the current project: Click on the Sheet properties… 
button in the Sheet toolbar to display the sheet properties in the Properties 
window. 

 

 
 

 Change the sheet name under General -> Page Name from Work Area to Plan 
CWL, for example. 



 
 

__________________________________________________________________ 
© DigiPara GmbH  LD Quicktour V5, Sept.  2007 

52 Plan view  _

 
 

4.9.5. Saving the Settings in an External Template file: 

Select Save sheet template from the Sheet pull-down menu. In the dialog 
displayed, enter Plan CWL as the filename. You can now use this configuration file 
to load the same settings for other projects. To do this, go into the Sheet menu and 
select Load sheet template.  This will load the file Plan CWL.LDS. 
 
The filename Plan CWL indicates that the sheet file contains settings for a Plan 
view with the configuration Counter Weight Left. If you need other view 
configurations, you can save them in additional sheet files with a different sets of 
plan view settings.  
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5. Sectional Vertical View 

5.1. Changing Views 

 Switch back to the sheet “Work Area”. 
The buttons in the Views selection toolbar enable you to directly switch between 
the available views of the elevator. 
 
 

 
 
From left to right: 
 

1. View Frame Properties: 
2. Load View Frame 
3. Save View Frame  
4. Add View Frame  
5. Remove View Frame  
6. Switch view frame to Plan view  
7. Switch view frame to Vertical sections facing left / front / rear / right shaft 

walls; Switch view frame to Machine Room view  
8. Switch view frame to Roller arrangement view 
9. Switch view frame to Entrance view 
10. Switch view frame to 3D view 
11. Switch view frame to External drawing block 

 

 Switch to the Work Area template, then click on the button for the vertical 
section facing the left shaft wall or select Vertical section – View from right in the 
View frame menu.  

 

 WARNING: Any changes made to the current view settings – for example: 
scale, dimension display or component visibility – will be lost if you don’t save 
them in a sheet template before switching to another view!  

 

5.2. Building Floor Levels 

Now we want to make some changes to the landing and travel parameters in the 
floor level list. To do this, select Project > Floor Levels… from the pull-down menu 
to open the Floor Level configuration window.  
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 Make the changes shown above then click on OK to exit the dialog. The 
drawing will be updated automatically.  

 
You can add and remove floor levels by using the appropriate buttons. Add two 
new floor levels and edit their parameters by clicking in the corresponding fields. 
Then enter the necessary values and description. You can activate and deactivate 
entrances on individual floors by clicking on the corresponding fields in the Front 
and Rear columns. 
 
Column description: 
Height: Distance between landings or distance to shaft pit 

(bottom) or shaft head (top) 
 

Description: 
 

Landing description 

Front/Rear: 
 

Front and rear entrances 

Ceiling: Vertical distance from finished floor to lower surface of 
floor level (e.g. for suspended ceilings). 
 

Level: Enables you to enter the exact height as shown in the 
architectural drawing 
 

Assembly Platform: Number of Assembly platforms on the selected floor level 
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5.3. Rail Bracket 

Select a rail bracket to display its vertical dimensions.  

 Change the rail bracket span to 80’’.  
 

 Confirm the following prompts with Yes to perform the same changes for all rail 
bracket spans. Activate the rail calculation module to check that the maximum 
stress will not be exceeded with these spans.  

 Change the span between the pit and the first bracket to 20’’.  
 

 Caution: Confirm the prompt displayed after entering the new value with No, 
otherwise all rail brackets spans will be set to 20’’. 
 

 Change the span between the last bracket and the preceding bracket from 16’’ 
to 34’’ as shown in the example below. 
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5.4. Configure and Save the view 

5.4.1. Dimensions, Scale, Hatching and Components 

The basic procedures here are the same as those described in the Plan View 
chapter.  
When you activate the view, you will notice that some dimensions do not seem to 
be there.  For example, the rail bracket and guide rail dimensions. Click on the 
component, then click on the toolbar icon shown below to set the dimensions in 
this view to “always display”.  
 

 
 
After making a few of these changes, your drawing will look something like this:  
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5.4.2. Saving the Settings 

Select the plan view frame, if it is still on your drawing sheet. Then delete the view 
frame from your drawing by clicking on View Frame then select Remove View 
Frame in the View frame pull-down menu. Proceed as described in the Plan View 
chapter and give the sheet template the name VertSec CWL.  
 

 
 

6. Dynamic 3D view 

This feature is part of the 3D Render module. You can always display the current 
view in dynamic 3D. Click on the Dynamic 3D View button in the Standard toolbar 
or select Dynamic 3D View from the Window pull-down menu. 
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You can rotate the view around a defined point by dragging it with the left mouse 
button. Dragging it with the right mouse button moves the view within the window. 
 

 
 
You can define the center point of rotation by switching to one of the orthogonal 
views (with the icons at the right-hand side of the toolbar) and shifting the model as 
required. 
 

 To display a 3D view of the entire elevator , close the current view and select 
the 3D View from the View Frame toolbar: 
 

 
 
 

 If you like, you can also disable the display of the shaft and the machine room 
in the 3D mode. Just click on the icons on the right-hand side of the toolbar as 
shown below.  
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7. Machine room 

7.1. Size and Position 

 Activate the machine room view and check that the work area is activated.  
The dimensions shown below determine the machine room location. The position 
is defined in relation to the lower left edge of the shaft ceiling.  
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 Enter 20’’ for the vertical dimension and 40’’ for the horizontal dimension. The 
position of the machine room will be shifted accordingly.  

 The dimensions for the size of the machine room are clearly visible. Enter a 
value of 160’’ along the vertical shaft axis and 120’’ along the horizontal shaft 
axis.  

7.2. Openings 

Turn off the machinery display by clicking on the sheaves icon in the components 
toolbar. Then select a rope opening – this displays some additional dimensions.  
 

 Change the opening dimensions for both ropes to 8 x 8’’. 
 
You can also adjust the opening dimensions with the guide dimensions. To do this, 
select an opening and display its properties. Then click on the Component 
annotation button in the Edit Object toolbar. 
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 In the dialog, click on the DT button to display the default text for the 
component. 

 

 
 
This displays the guide dimensions, which you can adjust by selecting and 
dragging it with the left mouse button.  
 

 
 
Repeat this procedure for all the other rope openings, including those for the 
governor (you will need to disable the governor display to do this).  
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7.3. Other Machine room Components 

You can make rough adjustments to the position of the switchgear cabinets, doors, 
ventilation openings, etc. by selecting them and changing the values in their 
properties dialog boxes.  

 Fine adjustments are made with the additional dimensions that are displayed in 
the drawing when the components are selected.  

7.4. Configuration and Saving the view 

Proceed as described in the chapters regarding the other view types. Name the 
sheet template Machine Room CWL and use the configuration methods described 
above.  

8. Wall Opening 

8.1. Hall Button and Position Indicator 

Create a new drawing sheet by clicking on the Sheet pull-down menu then 
selecting Add sheet and switch it to a wall opening view.  
 

 Select one of the panels and delete it, by clicking on the Delete selected Object 
button in the Edit toolbar. 
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8.2. Fixing 

Add a new view frame and switch it to an “Entrance” view. Select one of the door’s 
upper fixing points and display its properties.  
 

 In the Quick Component Link box select the parent “Landing Door Fixing 
Points”. 

 

 
 

 Switch the “One large anchor rail” and the “Arrange manually” option in the 
property window to “Yes” to activate the anchor rails for the upper door fixing 
points.   

 
 
Repeat this procedure for the lower fixing points. Then disable the door/car display 
by clicking on the first icon in the component’s toolbar.  
 

 Change the length of the upper and lower rails to 60’’. 

8.3. Configure and Save the view 

Using the methods you are now familiar with, change the view settings so that your 
drawing looks like the example below and save your sheet template as Wall 
Opening CWL.  
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9. Creating an Assembly Drawing 

9.1. Combining the Prepared Views 

Now we are going to combine all the views we have configured into an assembly 
drawing:  
 

 Add a new sheet by clicking on the Sheet menu and selecting Add Sheet.  Give 
the sheet the name Assembly A1 CWL. 

 Switch to the template Plan CWL and select the view frame.  
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 Press Ctrl + C to copy the contents of the view frame to the clipboard. Switch to 
sheet template Assembly A1 CWL and paste the contents of the clipboard by 
pressing Ctrl + V. 

 
Repeat steps 2 through 4 for all your other sheet templates.  

9.2. Frame and Title Block 

Click on one of the view frame borders and then select the parent ”..\Sheet x” 
component in the Quick Component Link box to display the sheet’s properties. 
 

 
 
Click on the button in the Name of title block value field and select the 
titl_sml_int_Imp.dwg title block. 
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The texts in the titl_x_int.dwg title blocks will switch automatically according to the 
selected drawing language. By contrast, the texts in the titl_x_gb.dwg title blocks 
will always remain English, independent from the selected drawing language. 
 
Repeat this procedure for the Name of drawing border value and load the file 
bord_ANSI_E_Imp.dwg as the drawing border. 
 
 
Select the individual view frames and change their positions as required. The final 
result will look something like the example shown below.  
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